S32K344 MCAL Integrate with S32DS

2> Stephen Du

I Foreword

This document will not guide you how to configure a MCAL project with EB Tresos. The pre-condition is that you
already complete the configuration of your MCAL project and there is no error with code generation. (If you want to
know how to work with EB Tresos to create a project, please refer other material)

And if your project is using makefile or something similar with that to construct your target files, you can ignore this
document. This document is for who wants to use S32DS to compiling and debug.

I 1. New Project

1. Open S32DS V3.4 or later version. Then File -> New -> S32DS Application Project .

ﬁ workspace53205.3.4 - 532 Design Studio for 532 Platform
File Edit Source Refactor Mavigate Search Project ConfigTools Run Window Help

Mew Alt+Shift+N » = S32DS Project from Example Ctrl+Alt+E
Open File... B S32DS Library Project Chrl+Alt+L
=
3 Open Projects from File System.. - 53205 Application Project Ctrl+Alt+A
Recent Files » = Makefile Project with Existing Code
J 9
© C/C++ Project
Close Ctrl+W : IE:qud e
Close All Ctrl+ Shift+W

Cownvart try a CAC ++ Proiact (Adds O/ ++ Matire)

7

2. Input you project name and select the chip type.
ﬁ 53205 Application Project O X

Create a 532 Design Studio Project
Mew 53205 Application Project

Project name:
S32K344 WB_MCAL Demo

Use default location

11 CAUsers\NXF5013M\workspace532D5.3.4 Browse...
Processors: ToolChain Selection:
|ty|:|e filter text Core Kind  MName Toolchain
B Famil_',r SI2K e M7 Cortex-M7  NXP GCC 9.2 for Arm 32-bit Bare-Metal w
¥ = Family 532K3xmx
B 532K314 Desciption:
B 532K324 GNU 9.2 Toolchain is selected A
B 532K344
L
@ < Back Next > Finish Cancel

3. Select library and set FPU and so on.

If you want to print something in console, you can select Debugger Consoler at 1/0 Support item, Otherwise select
No I/0.For "FPU Support" item, suggest you select: Hardware: -mfloat-abi=hard .

SDKs item keep None, because we will not use any LLD but MCAL. Debugger item depends on your device.
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ﬁ 53205 Application Project O X

Mew 532DS Project for 532K344

Select required cores and parameters for them.

Project Name 532K344 WB_MCAL_Demo

Core Cortex-M7

Library Newlib W
I/0 Support No /O et
FPU Support Hardware : -mfloat-abi=hard ™
Language C W
S5DEs
Debugger GDB PEMicro Debugging Interface b

@ < Back Next > | Finish | Cancel

4. Click to create project. In default, it will help create the startup code, vector table file, link file, some
header files and the main.c file and so on.

~ = 532K344 WB_MCAL_Demo: Debug_FLASH
» @ Includes
v @ Project_Settings
v = Startup_Code
» 4 boot_header.c
> & startup_ARMCM7 .c
» i system_ARMCMYT .c
» @ Debugger
v @ Linker_Files
@ 532K344 flash.Id
B S32K344 ram.id
@ include
5rc
i main.c

&
&

I 2. Remove Files

1. Delete unnecessary files. Here we need delete the "include" folder which created by default. These header files in
"include" folder are for LLD code using and MCAL has its own header files(even through most files are the same, but
still few files are different) which are located in "MCAL\Base_Ts_T4xxx\header" .

2. Delete the "startup_code" folder and "Linker_Files" folder which located in "Project Settings". MCAL will use its
own link file and startup file, which are located in the following path: "McAL\Platform_TS_T4xxx\build_files\gcc" and

"MCAL\Platform_TS_T4xxx\src\m7" .

In fact, we can also use files created by S32DS, but some content may need to be modified, so in order to reduce
our workload, we use MCAL files, which can save a lot of time.

| 3. Add MCAL

1. Copy the "include" and "src" folder of the modules which you used. These folders located in the plugin folder.
The default install path is: "c:\NxP\AUTOSAR\" . If you installed multiple product versions, there will be many different
product version folders, go into the right folder and find "eclipse\plugins" . You also can copy all modules' folder
except the * jar file. Please refer the following picture, just copy the selected folder. We put these folder into one
folder named "mcaL" and located in the project root path.

If you only copy the modules which you used, you can ignore step 3.3. Attention, their may have some problem if
you are fresher on MCAL, the problem is how to know which module you used. for the these module which related
with hardware, its easy to identify. For example, the "Adc" module or "Spi" module and so on. If we want to use it,
we need configure it. but the problem is that some modules are the common module, like the "Base"” and "Rte"
module, even we didn't configure it, but some other module dependent on them. so we also need copy these
common modules.
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Mame

Adc_T5_T40D17TMENRD
Base_T5_T40D17MEITRO
Can_T5_T40017MENRD
Canlf_T5_T40D17MENRD
ComDal_T5_T40017MENRD
CryptoDal_TS5_T40D17MENRD
Dem_T5_T40D17MEITRO
Det_TS_T40D17MEITRD
Dio_T5_T40D17MEITRD
EcuC_T5_T40D17MENRD
Ecul_T5_T40D17MEITRO
Eth_TS_T40017MEINRD
Ethif_T5 T40D17MEITRO
EthSwt_T5_T40D17MEN RO
EthTrow_TS_T40017MENRD
Fee T5_T40D17MENRD
Fls_T5_T40D17MEITRO
Fr_T5_T40017MENRD
Frif_T5_T40D17MENRD
Gpt_TS5_T40D17MENRO
[2c_T5_T40DTMBIRO
lcu_T5_T40D17MENRD
leDal_T5_T40D17MENRD
Lin_TS5_T40017MENRD
Linlf_T5_T40D17MENR0
Mel_T5_T40D17MENRD
Meu_TS5_T40D17MENTRO
MemDal_T5_T40D17MEITRD
Mernlf_TS_T40D17MEITRD
Ocu_TS_T40017TMENRD
Os_T5_T40D1TMENRD

Platformintegration_T5_T40017MEINRD

Port_TS_T40D17MENRD
Pwm_T5_T40D17MENRD
Resource_T5_T40D17MENTRD
Rte_T5_T40D17MEITRD
Spi_TS_T40D17MENRD
SysDal_T5_T40D17MEITRO
Wdg_T5_T40D17MEITRD
Wdglf_TS_T40D17MEITRD

|2 | com.freescaletools.tresos.xpath.jar
|2 | com.nxp.tools.tresos.xpath.sqrtjar

|2 | freescaletresos.flexray.jar

Date modified

3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/26/2020 4:52 PM
3/26/2020 4:52 PM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/26/2020 4:52 PM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/26/2020 4:52 PM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/26/2020 4:52 PM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/26/2020 4:52 PM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
12/14/2018 £:34 PM
12/14/2018 7:38 PM
12/14/2018 8:17 PM

» O5Disk (C:) » NXP » AUTOSAR » S32K2_MCAL4L 3 EAR 0 31 » eclipse » plugins

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
Executable Jar File
Executable Jar File

Executable Jar File



5 532K344 MCAL Demo: Debug |

& Binaries

» i Includes
r @ FreeRTOS 532K

2 MCAL

¥ & Base_TS_T40D34MEI0R0

= include

* & SrC

v = Lan_|5_l40034MEIDRD
& include
* B 5C
= Canlf_T5_T40D34MBIOR0
& Dem_T5_T40D34MEI0OR0
» @ Det_TS_T40D34MBIORD
+ = Dio_TS_T40D34MBI0OR0D
i= EcuM_T5_T40D34MBI0OR0
» = Fee _T5_TA0D34MEIORO
» = Fls_TS_T40D34MEIORD
i= Gpt_TS_T40D34MBI0R0
» @ 12¢_TS_T40D34MBIORD
1= lou TS _T40D34MBIORO
@ Lin_TS_T40D34MBEI0R0
» = Linlf_TS_T40D34MEI0R0
1= Md_TS_T40D34MBI0R0
iz Mou_T5_T40D34MBIORD
» @ Memlf_TS_T40D34MBIOR0
1= Ocu_T5_T40D34MBI0OR0
iz Os_TS5_T40D34MBI0RD

ASH

¥ i Platform_T5_T40D34MBI0R0

= build_files
& gec

» &= include
¥ = SIC

i Port_T5_T40D34MEI0OR0
* & Pwm_TS_T40D34MEIORD
* = Rte_TS_T40D34MEI0R0

& Sbe_fs26_TS_TA0D34MBIORD

» = 5pi_TS_T40D34MBIORD
* 4= Wdg_TS_T40D34MBIORO

» @ Adc TS T40D34MEI0RD

> @ Crylf TS_T40D34MBIORD

» @ Crypto_TS_T40D34MBIORD
» % Csm_TS_T40D34MBIOR0D

» @ Fth TS T40D34MBI0R0

@ Ethif_T5_T40D34MEIOR0

2. Attention again, except Base and Platform module, all other modules only copy "include" and "src" folders. You

need delete all unnecessary files/folders under each module's folder. Only keep "include" and "src" folders. The

following picture take "Adc" module as an example, delete the selected files/folders, the other modules are same.
For "Base" and "Platform" modules, we can see from above picture, we need copy "header" and "build_files"

folders besides "include" and

» OSDisk (C:) » NXP » AUTOSAR » S32K2XX_MCAL4 3_EAR 081 » eclipse » plugins » Adc_TS_TA0D17MSITRD

Mame

autosar

config

doc
generate_PB
generate PC
generate_swecd
include
META-IMF

src

anchors.xml

ant_generatorxml

| pluginxml

i

Date modified

3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
3/3/2020 10:52 AM
12/14/2018 8:04 PM
121472018 8:04 PM
12/14/2018 8:04 PM

Type Size

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
AML Document 2 KB
#ML Document 4KE
XML Document TKB

3. Before you do the following process, | strongly suggest you "Refresh” the project folder tree first(You can press
"F5"). In the previous step 3.1, If you only copied the module you used, you can ignore this step.

Disable the modules which you did not used, otherwise it will cause many compiling error. Select the module
folder in the project tree and right click. Then Build path -> Remove from -> Debug_FLASH .



L

v 5 532K344 MCAL_Demo: Debug FLASH * main implementation: us

» 4 Binaries =/
> @ Includes #include "S32K344.h"
» @ FreeRTOS 532K
v = MCAL #if defined (__ghs_)
#define INTERRUPT_S\
W = Adc T‘S TANMTALAD DN — —
B [ , #define _ NO_RETURN__
& Base_l. #elif defined (__ICCARM_ )
» i#CanJs  Golnto #define _ INTERRUPT_S\
» @ Canlf_T Open in New Window _#defil:ie __NO_RETURN__
= Dem T . #elif defined (__GNUC__)
oDty oW Alt+Shift+W > #define _ INTERRUPT S\
= 7P show in Local Terminal > #define _ NO_RETURN__
» @& Dio_T5) . | felse
» = Ecum_1 & Copy Ctri+C #define _ INTERRUPT_S\
& Fee TS| * Delete Delete #define _ NO_RETURN__
> mFsTS | Loste Ctrl+V #endif
2o ™ Rename.. F2
> &6ptTS %5 3 int counter, accumulator =
> & 12¢ TS uree
» 8 lew TS, Move... ~int main(void) {
> & LlinTS_ s Import... counter = 8;
» i=Li =
Linlf TS & Export for (53) {
> @ MdTS, Build Project counter++;
P =M Refresh F5 .
» & Memilf, if (counter »>= lin
. = OcyTs 'ndex * __asm volatile
» = 0s TS Build Targets » counter = @;
s g Platfon Resource Configurations ] ' }
» & Port_TS Build path 3 Add to 3 r to avoid the warnir
CEPemT pigrate.. Remove from > Debug_FLASH
* &= Rte TS,
» & Sbe fs: Restore from Local History... } Release FLASH
- i i Debug_RAM
. &= SpiTS. ® 532 Configuration Tools » T ug_|
) i>WdgT ~ Team > ;  Release RAM
> @ Crylf T! Compare With ] T
» @ Crypto Source 3
» @£ Csm T4 ¥ Validate
» @ Eth TS Properties Alt+Enter

Then it will move to the tail and color will change to gray. You can select multiple folders once time. If you want to re-
active the module, the method is same, under Build path, select Add to -> Debug FLASH .

> &y Spi_TS_TADD17M8I1RO
» & Wdg_TS_TA0D17MB8I1R0
+ £ Adc_TS_T40D17MBI1RO
» @ Canlf TS T40D17MEITRD
» @ Eth_TS_T40D17MEBITRO
> @€ Ethlf_TS_TA0D17MB8I1RO

Attention: There have three options, Debug FLASH, Release FLASH, Debug RAM. Commonly, the project's default
state is Debug FLASH, you can check the state from the project tree. Please refer the following picture.

v 5 532K344 MCAL DemoQQibuo FLAST)
» & Binaries
* @ Includes
» @ FresRTOS 532K
w 2 MCAL
» @ Base T5_T40D34MEIORO
» = Can TS T40D34MBIOROD
» = Canlf_TS_T40D34MEI0R0
» @ Dem_T5_T40D34MEI0R0

If you want to change to release, right click on project name, select Build Configurations -> Set Active -> Release
FLASH . If you change this, the previous process (Add/Remove module) need synchronize.
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WhiteBoard MCA' ™
# Binaries
» @l Includes
v & MCAL

* @y Adc_TS_T40D1 &

+ &y Base _TS_T40D1
&y Can_TS_T40D1
& Dem_TS_T40D"
+ &y Det TS_T40D1]
&y Dio_TS_T40D17
& EcuM_TS_T40D
+ &x Fls_TS_T40D17
&y Gpt_TS_TA0D1;
@ 12¢_TS_TAOD17
+ &y lou TS _TAOD17
&y Lin_TS_T40D17
& Linlf_TS_T40D1
» &y Mcl_TS_T40D1]

L

L

L

L

e

L

B
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L
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&y Mcu_TS_T40D1
& Ocu_TS_T40D1

e Os_TS_T40D17

ke

<

&y Port_TS_T40D1

# Dashboard &

~ Project Creation
" 532D5 Application P

EE

L e B o

L T Tl N T T T Ve T T I, T -1CA.I_D
er

4 /*EXTERN(_ZN18__ cxxabiv119 t

New » 5
o nt 6_ STACK_SIZE = exeeeeleee;
@ me 7__HEAP_SIZE = ©x@28810800;
Open in New Window - . . .
8/* Linker script to configure
Copy Ctrl+C 18 MEMORY
Paste Ctrl+V 114
Delete Delete 12 BOOT_HEADER (r) : ORIGIN
Rename... F2 13 XRDC_CONFIG (r) : ORIGIA
14
Sl ' 15 CM33_FLASH © (rx) : ORIGIM
Move... 16 CM33_FLASH 1 (rx) : ORIGIM
17 CM33_RaM (rwx) : ORIGIM
Import... 18 -
Export... 19 CM7_FLASH  (rx) : ORIGIN
Build Project 28 CM7_RAM (rwx) : ORIGIM
- 21
Clean Project 22 CM7_RAM FLS  (rwx) : ORIGI
Refresh F5 23 CM7_RAM_EEP  (rwx) : ORIGI
Closs Projact 24 CM7_RAM_MCU  (rwx) : ORIGI
Close Unrelated Prol 25 CM7_RAM HSE  (rwx) : ODRIGI
ose Unrela rojects 26}
Build Targets > ol . .
2B /* Linker script to place sec
Index L 78 _* with athar Tinkar errint +
Build Configurations » Set Active * & 1 Debug_FLASH
Bulld pﬂth 3 MHHEQE'... 2 m
Build Configurations Explorer Build All 3 Release_FLASH
SDKS clean Al wvirdv etart
Migrate p] Build Selected...

I 4. Property Setting

- R

1. Now, we need include all modules' header file path in project's property. Right click on project name, click
Properties. Then c/C++ Build -> Standard S32DS C Compiler -> Includes .

e Pay attention to Base module, it need includes two paths. one is "include”, another is "header".

e And the Platform module also a specially module, you need set the startup header file path.
e Don't forgot to add the MCAL generated codes' header file path.

[E Properties for 532K344 MCAL Demo

type filter text
» Resource

C/C++ Build
Build Variables
Environment

Logging

Tool Chain Edr
» C/C++ General
EmbSys Register”
Praject Matures
Project Reference:
Run/Debug Settir
532 Configuration
SDKs
Task Tags
> Validation

Settings

Configuration: Debug_FLASH [ Active |

% Tool Settings # Build Steps

¥ Cross Settings
(# Target Processor

|+ ® Standard 53205 C Compiler]

i

£

{

£

(& Dialect

(# Preprocessor
e

& Optimization

# Debugging

& Warnings

& Miscellaneous

® Standard S32D5 C Linker

& General
& Libraries
# Miscellaneous

# Shared Library Settings

& Link Order

% Standard 532DS Assembler

& General
(& Preprocessor
# Debugging

® Standard S32D5 Create Flash Image

& General

% Standard 532DS Print Size

£ General

® Standard 53205 C Preprocessor

¥ Settings

® Standard 532D5 Disassembler

(& Settings

Build Artifact i Binary Parsers @ Error Parsers

Include paths (-1)

W

Manage Configurations...

€ o @G L

"${ProjDirPath}/generated/include”
"4{ProjDirPathl/MCAL/Adc TS TA0D34MBIORD include”
* HProjDirPathl/MCAL/Base_TS_T40D34MBI0R0/header
'${ProjDirPath}/MCAL/Base_TS_T40D34MBI0RD/include”
'${ProjDirPathl/MCAL/Canlf_TS_T40D34MBIORD/include”
"4{ProjDirPath}/MCAL/Can_TS_T40D34MB8I0RD/include”
'${ProjDirPathl/MCAL/Crylf_TS_T40D34M8IOR0/include”
"${ProjDirPathl/MCAL/Crypto_TS_T40D34MBIDRD/include”
"${ProjDirPath}/MCAL/Csm_TS_T40D34MBIORD/include"
'${ProjDirPath}/MCAL/Dem_TS_T40D34MBIORD/ include”
"${ProjDirPathl/MCAL/Det_TS_T40D34MBIORD/include”
"4{ProjDirPath)/MCAL/Dio_TS_T40D34MBIORD/include”
'${ProjDirPath)/MCAL/EcuM_TS_TA0D34MBIORD/include”
"$iPrajDirPathl/MCAL/EthIf_TS_T40D34MBI0RD/include”
"4{ProjDirPath}/MCAL/EthSwt_TS_T40D34MBIOR0/include”
"${ProjDirPathl/MCAL/EthTrov_TS_T40D34MBI0R0/include”
"4{ProjDirPathl/MCAL/Eth_TS_T40D34MBI0ORD/include”
"4{ProjDirPath}/MCAL/Fee_TS_T40D34MBIOR0/include”
"${ProjDirPath}/MCAL/Fls_TS_T40D34MEI0R0/include”
"${PrajDirPathl/MCAL/Gpt_TS_T40D34MBIORD include”
"$1ProjDirPath}/MCAL/12c_TS_T40D34MBIOR0/include”
"${ProjDirPathl/MCAL/Icu_TS_T40D34MBIORD include”
"${ProjDirPathl/MCAL/Linlf_TS_T40D34MBI0R0/include”

Tl lal

e I LN LT Tal NI I i o Ta et N LN Tallalaran o

Include files (-include)

&8 B

]
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ﬁ Properties for 532K344_Test_440 090 O

type filter text Seﬂings -
» Resource
" E:giﬁrsﬂuild Configuration: Debug_FLASH [ Active | ~ | Manage Configurations...
Build Variables
Environment % Tool Settings # Build Steps  Build Artifact & Binary Parsers @ Error Parsers
Logging
Settings & Cross Settings Include paths (1) €8 &8 j 8
Tool Chain Edi ¢ Target Processor "${ProjDirPath}/MCAL/Fls_TS_T40D34MSI0OR0/include” ”
» C/C++ General v ® Standard $32DS C Compiler "${ProjDirPath}/MCAL/Gpt_TS_T40D34MII0RD/include”
EmbSys Register B Dialect “${ProjDirPath}/MCAL/12¢_TS_T40D34MIORO/include”
Project Natures & Preprocessor "§{ProjDirPathl/MCAL/lcu_TS_T40D34M39I0R0/include”
. B Inchudes “${ProjDirPathl/MCAL/Linlf_TS_T40D34M9I0RY/include”
Project Reference _-— “${ProjDirPath}/MCAL/Lin_TS_T40D34M9I0R0/include”
Run/Debug Settir & Optimization "${ProjDirPathl/ MCAL/Md_TS_T40D34M3I0R0/include"
532 Configuration & Debugging *${ProjDirPath}/MCAL/Mcu_TS_T40D34M9I0R0/include”
SDKs & Warnings “UProjDirPathl/MCAL/Memilf_TS_T40D34MIIORD/include"
Task Tags & Miscellaneous "§{ProjDirPathl/MCAL/Ocu_TS_T40D34M9I0R0/include”
» Validation ~ 1 Standard $32D5S C Linker "${ProjDirPathl/MCAL/Os_TS_T40D34MII0RD include”

“${ProjDirPath}/MCAL/Platform TS T40D34M9I0R0/include”
|"S-:F-‘rI:-iI:lirP-ul.h}_.-"l‘u‘l'!:.ﬁ'-L_.-"F'Ial.f-:-rm_TS_TdEI[}3‘:4?-'1EIII:IF!.I:I.-"&:tartuu,-"in-::lude"

& General
& Libraries

*${ProjDirPathl/MCAL/Port_TS_T40D34M3I0R0/include”
“${ProjDirPathl/MCAL/Pwm_TS_T40D34M9IOR0/indude”
"UDrAiMirDathl /AT Al IRea TS TANDZARAGINRN Ancdda"

& Miscellanecus
& Shared Library Settings

You'd better use the relative path here.

You can copy from the following list (Note that different versions of the software may be different):

"${ProjDirPath}/include"
"${ProjDirPath}/generate/include"
"${ProjDirPath}/MCAL/Adc_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Base_TS_T40D34M9IORO/header"
"${ProjDirPath}/MCAL/Base_TS_ T40D34M9IORO/include"
"${ProjDirPath}/MCAL/CanIf_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Can_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Crc_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/CryIf_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Crypto_TS T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Csm_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Dem_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Det_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Dio_TS_T4@D34M9IORO/include"
"${ProjDirPath}/MCAL/EcuM_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/EthIf TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/EthSwt_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/EthTrcv_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Eth_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Fee_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Fls_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Gpt_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/I2c_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Icu_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/LinIf_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Lin_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Mc1l_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Mcu_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/MemIf TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Ocu_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Os_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Platform_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Platform_TS_ T40D34M9IORO/startup/include”
"${ProjDirPath}/MCAL/Port_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Pwm_TS T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Rm_TS_T4@D34M9IORO/include"
"${ProjDirPath}/MCAL/Rte_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Sai_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Sent_TS_T40D34M9IORO/include"”



"${ProjDirPath}/MCAL/Spi_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Uart_TS_T40D34M9IGRA/include"
"${ProjDirPath}/MCAL/WdgIf_TS_T40D34M9IORO/include"
"${ProjDirPath}/MCAL/Wdg_TS_T40D34M9IORO/include"

2. Define the necessary MACRO for project. Also in the property window. If your debugger is PE/Multilink and you
didn't configure MPU, suggest you don't define: "I CACHE ENABLE" and "D CACHE ENABLE". It will affect you
debug. If you plan to use FPU, you need define: "ENABLE_FPU" in here. That means the FPU is active by two
conditions, the one is the item when you create the project, you need enable FPU; another condition is this macro

definition.
W Properties for 532K344 MCAL Demno |
type filter text Settings b
’ :z?l:::;e Configuration: Debug_FLASH [ Active | ¥ Manage Configuration:
v C/C++ Build
Build Variables | & Tool Settings # Build Steps ' Build Artifact ki Binary Parsers @ Error Parsers
Environment
Logging # Cross Settings [ ] Do not search system directories (-nostding)
Settings (# Target Processor [_] Preprocess only (-E)
Tool Chain Edi ¥ ® Standard 532D5 C Compiler Defined symbols (-D) SR
» CfC++ General & Dialect INIT_STDBY_RAM
EmbSys Register ’ = Preprocessor
Project Natures & Includes
Project Reference & Optimization
Run/Debug Settir & Debugging
532 Configuration & Warnings
SDKs & Miscellaneous
Task Tags ¥ & Standard 532DS C Linker
» Validation & General
& Libraries
# Miscellaneous BTB_ENABLE
& Shared Library Settings ENABLE FPU
& Link Order
~ ® Standard 532DS Assembler
£ General
& Preprocessor
# Debugging
~ ® Standard 53205 Create Flash Image
& General
~ & Standard 532DS Print Size
_‘?Ge.-ner_a!_ o Undefined symbols (-U) el u

You can copy from the following list:

INIT_STDBY_RAM
ARMCM7_SP

SINTRAM
DISABLE_MCAL_INTERMODULE_ASR_CHECK
S32K3XX

S32K344

GCC

AUTOSAR_OS_NOT_USE
EU_DISABLE_ANSILIB_CALLS
USE_SW_VECTOR_MODE
I_CACHE_ENABLE
BTB_ENABLE

ENABLE_FPU

3. Check/Set device type for debug in property window.



ﬁ Properties for 532344 MCAL Dernc

type filter text | EmbSys Register View
» Resource Device d -
ihr evice description
Builders ol $32K344 NXP Microcontroller
v C/C++ Build 532K3 crocentrofie
Build Variables Device:
Environment S32K344 "t
Logging
N Core:
Settings
Tool Chain Editor Cortex-M7 -

» CfC++ General
EmbSys Register View
Project Natures
Project References
Run/Debug Settings
532 Configuration Tools
SDKs
Task Tags

» Validation

4. Set compiler parameters in property window.

About the compiler parameters, please refer the "xxx_ReleaseNotes.pdf". Our document and demo project also
take a reference from that file. Maybe there have some special requirements in your project, in such case, you
need very clear the parameters what does it mean, this out of the scope of this document. But | think most
settings apply to your project. For example, the startup file setting, the link file setting and so on.

If you want to generate some other formats output file, like *.mot, *.s19, *.bin and so on, you can check the item:
"Create flash image”, please refer the following picture. After you check this item, you need click | 2pp1y and close
button, and re-open the property window, then you can find that the left side menu will appear a new feature,
please see the following second picture.

type filter text Settings o ow -
> Resource A
Builders ® Tool Settings # Build Steps Build Artifact [ Binary Parsers @ Error Parsers

v C/C++ Build
Build Variables & Cross Settings Prefix arm-none-eabi-
Environment & Target Processor Path ${S32DS_K3_ARM32_GNU_9 2 TOOLCHAIN DIR}
Logging v & Standard 532DS C Compiler

| Seﬂ:ings @ Dialect Suffix

Tool Chain Edi & Preprocessor C compiler gcc

» C/C++ General & Includes Hex/Bin converter | objcopy

ister ' (2 Optimization
EmbSys Register P Listing generator | objdump

& Debugging

Project Natures

Project Reference: & Warnings Size command size
Run/Debug Settir & Miscellaneous Build command make
. . B 1
' S32 Configuratiol v & Standard $32DS C Linker Remove cormmand | rm -rf
SDKs 2 General

Create flash image

(# Libraries
[ ] Create extended listing

Task Tags
» Validation 2 Miscellaneous

2 Shared Library Settings Print size
& Link Order
& Standard S32DS Assembler

£

‘ &2 General

‘ (2 Preprocessor

, ¢ Debugging

& Standard S32DS Print Size

i &3 General

, # Standard S32DS C Preprocessor

i (# Settings

' & Standard S32DS Disassembler
(2 Settings

<

<

<

@ Apply and Close Cancel




:t}rpe filter text | Settings
» Resource .
Build:rs Configuration: Debug_FLASH [ Active | ~ Manage Configurations... *
v CfC++ Build
Build Variables | & Tool Settings # Build Steps * Build Artifact i Binary Parsers @ Error Parsers
Environment . -
Logging & Cross Settings Prefix |arm-none-eabi- ‘
Settings & Target Processor Path [$(532D5_K3_ ARM32_GNU_9_2_TOOLCHAIN_DIR} Browse...
Tool Chain Edi ¥ ® Standard 53205 C Compiler
» C/C++ General & Dialect Suffix |
EmbSys Register ' # Preprocessor C compiler gcc |
Git & Includes Hex/Bin converter |objcopy |
: & Optimization
Project Natures ’ . Listing generator | objdump ‘
Project Reference: & Debugging . =
Run/Debug Setti & Warnings Size command size |
5§32 Configuratio & Miscellanecus Build command make |
SDKs v B SI;;':BFEI ?32[}5 C Linker Remove command | rrm -rf |
nera
Task Tags R Create flash image
> Validation & Libraries
& Miscellaneous [] Create extended listing
& Shared Library Settings Print size
i Link Order
¥ @ Standard 532D5 Assembler
& General
& Preprocessor
& Daby Jgging
+ ® Standard 53205 Create Flash Image
(& General
~ & Standard S32DS Print Size
& General
+ ® Standard 53205 C Preprocessor
i Settings
¥ ® Standard 53205 Disassembler
(& Settings

Then you can select the output file format in the new feature window. Please refer the following picture.

:t}rpe filter text Settings - -
» Resource .
B 'Idu Configuration: Debug FLASH [ Active | “ Manage Configurations...
uilders
w (C/C++ Build
Build Variables | Tool Settings # Build Steps " Build Artifact [ Binary Parsers @ Error Parsers
Environment )
Logging & Cross Settings Output file format (-0) |Motorola S-record -
Settings 2 Target Processor [ Section: - text intel HEX
Tool Chain Edi v ® Standard 53205 C Compiler [] section: j .data Motorola S-record
Dialect Motorola S-record (symbols)
7 GGt General b Other sections {-]) Rarw bina ¥
EmbSys Register’ & Preprocessor |
Git & Includes
Project Natures & Optimization
Project Reference: & Debugging
Run/Debug Settir & Wamnings
$32 Configuratio & Miscellanecus
SDKs ~ ® Standard S32DS C Linker
Task Tags & General
» Validation (& Libraries

# Miscellaneous
2 Shared Library Settings
& Link Order
#® Standard 532D5 Assembler
& General
& Preprocessor
# Debugging
DS Create Flash Image

i

w ® Standard

% Standard 532DS Print Size
& General

® Standard 532DS C Preprocessor
(2 Settings

® Standard 532D5 Disassembler
(& Settings

{

F

£

Set the language standard to: ISO C99



type filter text

Settings

> Resource
Builders
v C/C++ Build

5DKs
Task Tags
> Validation

Build Variables

» C/C++ General
EmbSys Register '
Project Natures
Project Reference:
Run/Debug Settir
S32 Configuration

% Tool Settings # Build Steps

Build Artifact  Binary Parsers @ Error Parsers

(2 Cross Settings
(2 Target Processor

Environment
Logging v & Standard S32DS C Compiler
[E— (2 Dialect
Tool Chain Edi & Preprocessor
& Includes

(2 Optimization

i

2 Debugging
2 Warnings
2 Miscellaneous

2 General
& Libraries

2 Miscellaneous

v~ & Standard S32DS C Linker

2 Charad likhrans Qattinnac

Set optimization level. Here we set to -0s . This level is refer from ReleaseNotes.pdf. This is a global setting, in the

Language standard

Other dialect flags

ISO C90 / ANSI C89 i—std=c90}

ISO C11 (-std=c11)
ISO C17 (-std=c17)

real project, you can set the level according to your project's requirement. S32DS also support set the level for

each single file independently. And some other parameters need setting in this window. please refer the following

picture.

type filter text

» Resource
Builders
w C/C++ Build
Build Variables
Ernvironment
Logging
Settings
Tool Chain Edi
» CfC++ General
EmbSys Register
Git
Project Natures
Project Reference
Run/Debug Settir
532 Configuration
SDKs
Task Tags
» Validation

Settings

Configuration: Debug FLASH [ Active |

% Tool Settings # Build Steps

& Cross Settings
(2 Target Processor
~ B Standard 53205 C Compiler
& Dialect
& Preprocessor
& Includes
= Optimization
# Debugging
& Warmings
& Miscellanecus
~ % Standard $32D5 C Linker
& General
& Libraries
# Miscellaneous
& Shared Library Settings

Build Artifact i Binary Parsers @ Error Parsers

~  Manage Configurations...

Optimization Level

Optimize for size (-Os)

Other optimization flagq | -funsigned-char -fshort-enums -fomit-frame-pointer -fstack-usage -fdump-ipa-all

[ ]'char is signed (-fsigned-char)

‘bitfield' is unsigned (-funsigned-bitfields)
Function sections (-ffunction-sections)
Data sections (-fdata-sections)

Mo cormmon uninitialized (-fno-common)

[ | Do not inline functions (-fro-inline-functions)
[ ] Assume freestanding environment (-ffreestanding)

[] Disable builtin {-fno-builtin)

[ single precision constants (-fsingle-precision-constant)

[ Link-time optimizer (-flto)

[ Disable loop invariant move (-fno-move-loop-invariants)

About the "Other optimization flags", you can copy from following list:

-funsigned-char -fshort-enums -fomit-frame-pointer -fstack-usage -fdump-ipa-all

Set Debugging Level.

type filter text

» Resource
Builders
v C/C++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Edi
» CfC++ General
EmbSys Register
Git
Project Natures
Project Reference
Run/Debug Settir
532 Configuration
SDKs

Settings

Configuration: Debug FLASH [ Active |

¥ Tool Settings # Build Steps

& Cross Settings
(& Target Processor
¥ ® Standard 53205 C Compiler
& Dialect
& Preprocessor
& Includes
2 Optimization
# Debugging
& Wamings
& Miscellanecus
~ & Standard 532D5 C Linker

B Ranaral

Set Warnings parameters:

Build Artifact b Binary Parsers @ Error Parsers

Debug Level None

S

Manage Configurations...

her debugging flags  -ggdb3

| Generate geov information (-ftest-coverage -fprofile-arcs)
Toolchain default

Debug format

#



it}rpe filter text Settings
* Resource
pulders Configuration: Debug_FLASH [ Active Manage Configurati
w fC++ Build onfiguration: ug_ anage Configurations...

Build Variables
Environment % Tool Settings # Build Steps ' Build Artifact ki Binary Parsers @ Error Parsers

Logging
Settings # Cross Settings [] Check syntax only (-fsyntax-only)
Tool Chain Edi 2 Target Processor Pedantic (-pedantic) I
% CfC++ General ~ ® Standard 53205 C Compiler [_] Pedantic warnings as emors (-pedantic-errors)
EmbSys Register & Dialect [ Inhibit all warnings (-w)
Git & Preprocessor All warnings (-Wall)
Project Matures & Includes Extra warnings (-Wextra)
Project Reference: & Optimization ] Wamnings as errors (-Werror)
Run/Debug Settir & Debugging
532 Configuration & Wamings
SDks - Miscellaneous . Warn on various unused elements (-Wunused)
Task Tags ~ @ Standard 532D5 C Linker B - — -
3 Validation B General Wam if padding is induded (-Wpadded)

[ Wamn if floats are compared as equal (-Wfloat-equal)
[ ] Wam if shadowed variable {-Wshadow)
[ ] Wam if pointer arithmetic (-Wpointer-arith)

& Libraries
# Miscellaneocus
& Shared Library Settings

& Link Order [ Wamn if suspicious logical ops (-Wlogical-op)
~ % Standard 532DS Assembler [_] Wam if struct is returned (-Wagreggate-return)
& General [ ] Wam on undedlared global function (-Wmissing-declaration)
& Preprocessor Other warning flags | -Wstrict-prototypes -Wundef -Werror=implicit-function-declaration -Wsign-compare
& Debugging

About the "Other warning flags", you can copy from following list:
-Wstrict-prototypes -Wundef -Werror=implicit-function-declaration -Wsign-compare

Set link file and remove the default start files.

:t}rpe filter text Settings v - i
» Resource c
Euild:rrs Configuration: Debug FLASH [ Active ] * Manage Configurations... "
w C/C++ Build
Build Variables | Toql Settings # Build Steps * Build Artifact i Binary Parsers @ Error Parsers
Environment
Logging # Cross Settings Do not use standard start files (-nostartfiles)
Settings # Target Processor |:| Do not use default libraries (-nodefaultlibs)
Tool Chain Edi w ® Standard 53205 C Compiler [ Mo startup or default libs (-nostdlib)
» CfC++ General & Dialect ] omit all symbaol information (-s)
EmbSys Register & Preprocessor [ Mo shared libraries (-static)
Git & Includes it filec (-T)
Project Natures & Optimization "${ProjDirPath)/MCAL/Platform_TS_TA0D34MBIOR0/build_files/gec/linker_flash.Id”
Project Reference: & Debugging
Run/Debug Settir & Wamings
532 Configuration & Miscellaneous
SDKs ~ @ Standard S32D5 C Linker
Task Tags 2 General
> Validation & Libraries
& Miscellaneous
& Shared Library Settings
& Link Order
~ & Standard $32DS Assembler
Set linker miscellaneous.
:t}rpe filter text Settings
» Resource ;
) - Configuration: Debug_FLASH [ Active | ~ | Manage C
Builders
w /C++ Build
Build Variables | ® Tool Settings # Build Steps  Build Artifact & Binary Parsers @ Error Parsers
Environment
Logging & Cross Settings Linker flags --entry=Reset_Handler -lc -Im -Igcc
Settings & Target Processor Other options (-Xlinker [option])
Tool Chain Edi ~ ® Standard 53205 C Compiler
» CfC++ General & Dialect
EmbSys Register & Preprocessor
Git & Includes
Project Natures & Optimization
Project Reference: & Debugging
Run/Debug Settir & Warnings
532 Configuration & Miscellaneous
SDKs ¥ @ Standard S32D5 C Linker
» Validation & Libraries
# Miscellaneous
& Shared Library Settings
& Link Order

About the "Linker flags", you can copy from following list:

--entry=Reset Handler -Ic -Im -Igcc



All these parameters which mentioned above, you can set it according to your requirement.

I 5. Link EB Tresos Generated Folder

1. Link EB Tresos generated configure file for each module. About this, we have many solutions except link method.
For example you can copy the generated folder to our project folder. You also can specify the generate path to
our project directly in the EB Tresos setting. Link strategy can keep two projects (EB Tresos configure project and
S32DS project) independently.

Right click project name, New -> Folder .

v 15 632K344 MCA| Marmn: Pinkan Bl ACH * main implEmEntEtiﬂﬂ: use this 'C’

& Binaries New > ™ Project...
> i Includes Go Into ? File
. @ FreeRTOS S Open i New Window : 53205 Fr;ject from Example Etrllfi}hE
53205 library Project Ctrl+Alt+L
B MCAL show In Alt+Shift+W > sl st
» B Project_Setti Show in Local Terminal ol 53205 Application Project |Create a new folder resource F‘
+ 19 generated|ir ' ' * File from Termplate
B nencrated/a B Copy Ctrl+C = Folder

Select your project, Expand Advances , select Link to alternate location(Linked Folder) , browse the generate folder.

Default path is under EB Tresos configure project, then output\generated .

[5 New Folder O X

Fold P
older =

@ The 'folder' name is empty.

Enter or select the parent folder:
532K344 WE_MCAL_Demao

! ¥
fi- =

= RemoteSystemsTempFiles
= 532K344 FEE Sample 081 34: Debug FLASH

¥

© = 532K344 WE_MCAL Demo: Debug FLASH

Falder narme:

[ Advanced > |

Folder name:

<< Advanced

() & Use default location

() = Folder is not lacated in the file system (Virtual Folder)
(®) = Link to alternate location (Linked Folder)

| Browse... Variables...

Choose file system: default ~

Resource Filters...

After you browser, click [ Finish |. Then you can find it under your project tree. The icon is different with others folder,
the linked folder has a arrow icon.

| suggest you put the EB Tresos configure project at the same root path with S32DS project.

. » 0O5Disk (E) » Project » 1
Mame

it

Doc

insight
Project_EB
Project_53205

Attention, if you use link method and when you import the project after you create a new workspace, don't select
copy project , otherwise, the linked folder will cause error, because it can't find the path.


af://n118

[ import g pod

Import Projects / L';'
|

% Some projects cannot be imported because they already exist in the workspace

(®) Select root directory: ! ; C ~ Browse...
() Select archive file: Browse...
Projects:
L] Select Al
Deselect All
£ » Refrazh
Options

[ ] Search for nested projects

E Copy projects into workspace
|| Close newly imparted projects upon completion
[_] Hide projects that already exist in the workspace

Working sets

[ ] Add project to working sets Mew...
Inrking sets W Select...

@ < Back Mext > Finish Cancel

I 6. Add Your Own Code

1. Add your own code in main.c or add intendent file/folder. Don't forget to add the header file path into project
property.

£-int main(void)

14

> #if (MCU_PRECOMPILE_SUPPORT == STD_ON)

3 Mcu_Init(NULL_PTR);

4 #elif (MCU_PRECOMPILE_SUPPORT == STD_OFF)

5 Meu_Init(&Mcu_Config);

6 #endif /* (MCU_PRECOMPILE_SUPPORT == STD_ON) */
7 Mcu_InitClock(McuClockSettingConfig_@);

8 while (MCU_PLL_LOCKED != Mcu_GetPllStatus())
s {

58 /* Busy wait until the System PLL is locked */
51 }

52 Mcu_DistributePllClock();

53 Mcu_SetMode (McuModeSettingConf_8);

55 /* Initialize Platform driver */

56 Platform_Init(NULL_PTR);

57 /* Initialize all pins using the Port driver */
58 Port_Init(NULL_PTR);

59 Mcl Init(&Mcl xConfig);

61 Task_GptDemo( );
62 Task_IcuDemo();
B3 Task_AdcDemo();
64 Task_FlsDemo();
65 Task_FeeDemo( ) ;
13 while (1)

2. Done. Till now, you have completed the integration work, you can start compiling and debugging.
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